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This User Guide provides information about OrbitGPS’s Serial
GPS receiver for vehicle docking cradles for mobile computers.

The OrbitGPS Serial GPS receiver is a SiRFstar Ill-based, WAAS-
enabled GPS receiver that collects GPS satellite data and
provides it to the mobile computer through the serial port of a
vehicle docking cradle. GPS information is available to the handheld computer when
docked. Two versions are available. One is powered by an external 12V cigarette lighter
adaptor and can be used with all MC900XX and MC70 vehicle cradles. The second
version can be used with MC70 cradle versions that output power through the serial
connector.

There are four versions of OrbitGPS’s Serial GPS receiver:

G1010 - For use with all vehicle cradles. This version is powered by a 12V DC
“cigarette lighter” adaptor.

(1020 — For use with vehicle cradle with power out through the serial connector. This
version is powered through the DB9 serial connector used to connect the receiver to
the cradle’s serial port.

(1030 - For use with Blackbay’s VMC2500 vehicle cradle for the Motorola MC70.

(1040 — For use with all vehicle cradles. This version is powered by a 12V/24V DC
direct-wire power adaptor with flying leads.

The OrbitGPS Serial GPS receiver outputs GPS information as industry standard NMEA

sentences which are compatible with most GPS software applications. It can also be
configured to output GPS information in the SiRF Binary format.
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OrbitGPS's GPS receivers offer typical accuracies of 3-5 meters uncorrected, and 3
meters or better with Wide Area Augmentation System (WAAS) correction.* They are
tested to comply with FCC and CE standards.

Note: Screens and windows pictured in this User Guide are samples and may vary.

The Serial GPS receiver is designed to work “out-of-the-box” with GPS applications that
accept data in the NMEA protocol format.

The National Marine Electronics Association regulates the NMEA 0183 specifications
standard which defines a set of ASCII strings, called sentences, which relay GPS
navigation information. This is the most commonly used standard for GPS
communications.

To configure the Serial GPS receiver for use with a GPS application that supports the
NMEA protocol, set the following parameters in the GPS application:

GPS Com Port or Com Port: COM1
Baud Rate: 4800

Protocol: NMEA (Depending on the GPS application, you may not be asked to enter
the protocol.)

Once these parameters have been set, the GPS application should begin automatically
receiving GPS data from the Serial GPS receiver. Please consult the GPS application
documentation for further information on how to communicate with an attached GPS
receiver.

nHES

The OrbitGPS Serial GPS Receiver is configured to receive GPS correction data from the
Wide Area Augmentation System (WAAS) and European Geostationary Navigation
Overlay Service (EGNOS) differential correction systems. Simply put, WAAS and EGNOS
broadcast additional correction data that is used to improve quality of the GPS data
provided by GPS receivers. The OrbitGPS Serial GPS Receiver will automatically acquire
and utilize the correction data of WAAS or EGNOS satellites available in the area of use.

For more information on WAAS visit:
http://gps.faa.gov/programs/waas/currentnews-text.htm

" #$% & "(
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The OrbitGPS Serial GPS Receiver with cigarette lighter power adaptor (OrbitGPS Part
(G1010) can be used with MC90XX S (Short) and K (Brick) and MC70 vehicle cradles. Set
up instructions are the same for all of these. In this installation, the GPS receiver draws
power from a 12V DC “cigarette lighter” adaptor. As long as the adaptor is powered, the
GPS receiver will operate. As such, the DC power jack needs to draw uninterrupted power
from the vehicle for constant operation of the GPS receiver. Install the vehicle cradle
before connecting the OrbitGPS Serial GPS Receiver.

When attached to the vehicle dock, the Serial GPS receiver allows the mobile computer,
when docked in the cradle, to capture GPS data.

To connect the Serial GPS to the vehicle cradle, plug the DB9 Serial connector into the
serial port found on the bottom of the cradle to the left of the power cable. Tighten the DB9
serial connector with the thumbscrews to ensure a secure connection.
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Connect PS2 style connecter coming from the DB9 Serial connector/power cable to the
PS2 connector coming from the GPS receiver.

Plug the cigarette lighter adaptor into a 12V DC power receptacle. The red LED light on
the adaptor will be it if power is available.
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Position the GPS receiver where it has a clear view of the sky for optimal performance.
The receiver is magnetized for use with vehicle roofs.

Motorola MC70 Cradle (VCD7000): The serial powered version of the OrbitGPS Serial
GPS Receiver (LP01632) can be used with RoHS-compliant versions of the MC70 vehicle
cradle that offer power out through the DB9 serial connector. Consult Motorola
documentation to determine if you have a compatible cradle. In this configuration, the GPS
receiver draws power from the MC70 mobile computer through the DB9 serial connector
and requires no additional power supply. As a result, the GPS is powered only when the
mobile computer is docked in the cradle and a valid GPS com port is open in a running
GPS application. If the mobile computer is undocked or goes into suspend mode, power is
no longer supplied to the GPS receiver. This situation may lead to slightly longer GPS start
times when the mobile computer is docked or is resumed after a suspend. Install the
vehicle cradle before connecting the OrbitGPS Serial GPS Receiver.

Intermec CN3 & 700 series: The serial powered version of the OrbitGPS Serial GPS
Receiver (LP01632) can be used CN3 and 700 series vehicle docks.

700 series — Use the serial port marked “A” on the back of the dock and follow the
instructions below. The serial GPS receiver will not operate if used with the serial port
marked “B.”

CN3 — To connect the serial GPS to the dock, you will need the Intermec serial
adaptor cable (Intermec part number 225-737-001).
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When attached to the vehicle dock, the Serial GPS receiver allows the mobile computer,
when docked in the cradle, to capture GPS data.

To connect the Serial GPS to the vehicle cradle, plug the DB9 Serial connector into the
serial port found on the bottom of the cradle to the left of the power cable. Tighten the DB9
serial connector with the thumbscrews to ensure a secure connection.

Connect PS2 style connecter coming from the DB9 Serial connector to the PS2 connector
coming from the GPS receiver.
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Position the GPS receiver where it has a clear view of the sky for optimal performance.
The receiver is magnetized for use with vehicle roofs.

$ &
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Simply, plug the RJ45 connector at the end of the GPS Receiver cable into the RJ45 port
on the back of the vehicle cradle. Note that older cradles may not have power out for the
GPS. Contact Blackbay for information on how to activate power out through the RJ45
port.
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To connect the Serial GPS to the vehicle cradle, plug the DB9 Serial connector into the
serial port found on the bottom of the cradle to the left of the power cable. Tighten the DB9
serial connector with the thumbscrews to ensure a secure connection.

6

Read the following instructions completely before beginning.

WARNING: A properly trained technician must perform the power connection.
Improper connection can damage the vehicle or GPSr  eceiver.

To connect the GPS receiver power cable to power:
1. Locate the Vehicle Power Source.

Note: An accessory output in the vehicle’s fuse panel is the ideal location for connecting
the power cable. The power cable should be added to a circuit with a maximum load
capacity for the GPS recevier and the original circuit. Refer to the vehicle’s owner’s
manual for identification of circuit. If a fused output is not available, an inline fuse holder
with UL-listed fuse should be used (fuse should be rated 4A for 24V operation and 5A for
12V operation). The fuse protects the vehicle from an electrical short on the power line to
the GPS receiver.

To provide constant power to the GPS receiver, shut the vehicle’s ignition, then connect
the power cable to unswitched power.

2. Route the power cable from the connection with the GPS receiver to the connection
point for the vehicle’s power source.

Caution: The means of routing and securing the power input cable from the GPS receiver
through to the vehicle power source is extremely important. Hazards associated with
improper wiring can be severe. To avoid unintentional contact between the wire and any
sharp edges, provide the cable with proper brushings and clamping where it passes
through openings. If the wire is subject to sharp surfaces and excess engine vibration, the
wiring harness can wear away, causing a short between the bare wires and chassis. This
can start a fire.

3. Prepare the cable termination.

a. Red wire: connect to a +12/24V vehicle power source.

b. Black wire: connect to vehicle ground or chassis ground.

Note: How the cable terminates depends on the vehicle. If the vehicle has a power output

connector, attach a mating connector to the end of the power cable. You may be able to
connect to a fuse panel with a simple blade terminal or commercially available connector.
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Consult the vehicle’s owner's manual for information on how to access the vehicle’s power
supply.

4. Connect the male PS2-style connector on the power cable to the female PS2-style
connector on the GPS receiver cable.

If the GPS receiver has power, the orange light on the top of the receiver will be lit. (Note,
once the GPS receiver has obtained a location fix, the orange light will blink).

757

No light— No power to GPS receiver
Light on continuously —  GPS receiver has power, but has not acquired a GPS fix

Light flashing on and off —  GPS receiver has power and has acquired a GPS fix
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The GlobalPoint GPS software provides a means to configure and confirm operation of
the Serial GPS receiver. In the GlobalPoint GPS software you will be able to choose the
mode of operation of the receiver and display positioning and performance information.

GlobalPoint GPS software can be downloaded at www.orbitgps.com/resources.html.

Use the Tools menu to access configuration options or to exit the program.

The tools menu contains the following options:
Reset Receiver
Change Receiver Protocol
Configure
Exit
Important Note: When first using the GlobalPoint GPS application, go to the Configure...

option first to set up communication between the Serial GPS Receiver and mobile
computer.

ORBITGPS USER GUIDE SERIAL GPS RECEIVERS



& &

Use the Reset Receiver option to select the Start Mode and begin a new initialization of
the receiver.

Cold Start causes the receiver to release any fix information and completely re-initialize
navigation data (almanac, ephemeris, and clock). Typical “Time to First Fix” (TTFF) is 45
seconds or less.

Hot Start causes the receiver to keep existing navigation data and refresh the fix. Typical
TTFF is 8 seconds or less.
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Change Receiver Protocol causes the receiver to switch between the two available
modes of operation: NMEA or SiRF. NMEA is the default mode of operation for the Serial
GPS Receiver for the mobile computers.

When in NMEA mode, choose this option to switch to SIRF mode.

The GlobalPoint GPS application requires the user to confirm switching the mode of
operation from NMEA to SiRF. To cancel the Change Receiver Protocol command, tap
on “Cancel.”
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When in SiRF mode, choose this option to switch to NMEA mode.

The GlobalPoint GPS application requires the user to confirm switching the mode of
operation from SiRF to NMEA. To cancel the Change Receiver Protocol command, tap
on “Cancel.”

The Change Receiver Protocol also allows the user to choose which NMEA sentences
are to be communicated from the Serial GPS receiver to the mobile computer. The
following NMEA sentences are supported by the Serial GPS receiver:

GSV - Set this NMEA sentence to the update interval for the GNSS Satellites in view.

GLL - Set this NMEA sentence to the update interval for the Geographic Position: Latitude
and Longitude.

RMC - Set this NMEA sentence to the update interval for the Recommended Minimum
Specific GNSS Data.

GSA - Set this NMEA sentence to the update interval for the GNSS DOP and Active
Satellites.

VTG - Set this NMEA sentence to the update interval for the Course Over Ground and
Ground Speed.

The default NMEA sentences for the Serial GPS receiver are GGA, GSV, GSA and RMC.
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Use this option to configure the connection between the Serial GPS receiver and the
mobile computer.

Com Port

This value determines the PC communications port the GPS receiver is connected to. The
default for the Serial GPS receiver is: COML1.

Baud Rate

This value determines the Baud Rate (or data transfer rate) at which the GPS receiver
communicates with the mobile computer. The default for the Serial GPS is: 4800.

Protocol

This value determines the mode of operation to be used by the Serial GPS receiver. The
default for the Serial GPS receiver is: NMEA

Auto Detect

Use this option to have the GlobalPoint GPS application automatically detect the Com
Port, Baud Rate and Protocol in use by the GPS receiver attached to the mobile
computer.

OK and Cancel

Select “OK” to save the settings selected or “Cancel” to disregard any changes.
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Use the Exit option to quit the GlobalPoint GPS application return to the Windows Mobile
“Today” screen.

Important Note: To fully exit the GlobalPoint GPS application, the Exit option must be
used. “Closing” the application by tapping on the “X” in the upper-right-hand portion of the
screen will not exit the program, but cause it to be minimized where it will continue running

in memory. If the GlobalPoint GPS application is running in memory, it will block other
GPS applications from running properly on the mobile computer.

Use the View menu to choose how tracking information is displayed within the GlobalPoint
GPS application.

The tools menu contains the following options:
Navigation
Satellites
Raw Data

These options can also be selected by tapping on the following icons:

Navigation

Satellites
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Raw Data

At the lower portion of the screen, just above the Tools menu, the GlobalPoint GPS
application displays the type of fix currently acquired by the GPS receiver. This value can
change over time as the receiver’s viewable sky changes, or if the receiver is re-initialized.
The types of fixes are:

#

Invalid unavailable solution — This signifies that not enough satellite data is available
to provide a fix. This occurs as the receiver is initialized or when an insufficient
number of satellites are in the viewable sky.

Corrected 3D point solution — This signifies that a three-dimensional GPS fix is
available and that it is corrected using WAAS or EGNOS. If available, WAAS
satellites are displayed in the satellite view as satellite numbers 35, 47. 48 and 51.
EGNOS satellites are displayed as 33. 37, 39 and 44.

Uncorrected 3D point solution - This signifies that a standard three-dimensional GPS
fix is available.

Uncorrected 2D point solution — This signifies that a two-dimensional GPS fix is
acquired.

Use the “Navigation” view to display summary data for GPS fix information communicated
from the GPS receiver.

Parameters displayed in the Navigation view are:
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Latitude — Displays the current location on the face of the Earth north or south of the
Equator. Latitude is an angular measurement ranging from 0°at the Equator to 90°at
the poles (90° N or 90° S). In the GlobalPoint GPS application, North is shown as a
positive value and South is show as a negative value.

Longitude — Displays the current location on the face of the Earth east or west of a
north-south line called the Prime Meridian. Longitude is an angular measurement
ranging from 0°at the Prime Meridian to +180°east ward and 180°westward. In the
GlobalPoint GPS application, East is shown as a positive value and West is show as
a negative value.

UTC — “Coordinated Universal Time or UTC,” is the equivalent of Greenwich Mean
Time, the astronomical basis for civil time.

Quality — Displays whether current fix is a “Normal” uncorrected fix or a WAAS
“Corrected” fix.

HDOP — “Horizontal Dilution Of Precision” is a measure of how the satellite geometry
influences the latitude and longitude data accuracy. A good satellite geometry and
hence a good accuracy is obtained if the satellites being tracked are located as far
away from each other as possible, while the geometry is poor if the satellites are
located close to each other. If the HDOP value is higher than about 10 the latitude and
longitude data likely to be inaccurate.

Speed — Displays the current velocity in miles per hour.

Heading — Displays the current direction of travel in degrees with North being 0°

Sats Used — The number of satellites used in the current fix. Note, WAAS and
EGNOS satellites are not included in the number, even if they are being used.

Protocol — The current mode of operation. This can be SIRF or NMEA.
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Use the “Satellite” view to display summary data about the available satellites in the
viewable sky.

Parameters displayed in the Navigation view are:

Satellites — This column displays all satellites available in the viewable sky by the
identifying number of each satellite as determined by the GPS authorities.

SNR - This value indicates the carrier signal to noise ratio for the signal received by
the individual satellite. Typically, satellites with SNR values below 28 are not used in
GPS fixes.

Satellite Sky Map — This graphic image displays the relative position of the viewable
satellites overhead.
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Use the “Raw Data” view to display raw GPS signal data being received by the GPS
receiver.

Tapping the “Pause” icon temporarily pauses the GPS data stream being received by the
GPS receiver. To resume the GPS data stream, tap on the pause icon. When active, the

pause icon will have a gray background. When paused, the icon will have a white
background.

Pause Icon (unpaused)

Pause Icon (paused)
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Windows® Mobile 2003

Windows® Mobile 2003 Phone Edition

Windows® Mobile 5.0

Windows® Mobile 5.0 Phone Edition

Windows® Mobile 6.0

Windows® Mobile 6.0 Phone Edition

Windows® XP and Vista

GPS Chipset:

Chipset Processor:

Frequency:

Signal Acquisition:

Channels:

Max. Update Rate:

Sensitivity:

DGPS Source:

DGPS Programmable:

System Back Up:

Antenna Type:

9)! 3(

I+

Autonomous:

WAAS

Velocity:

Time:

ORBITGPS USER GUIDE

SiRFstar IlI

ARM7/TDMI — 49MHZ

L1, CA code

1920 time/frequency search channels
20 Channels; all-in-view tracking

10Hz

-159dBm

Default: None

WAAS/EGNOS

Built-in Lithium-lon rechargeable battery

Built-in Antenna (external antenna optional)

<10m
<5m
0.1 meters/second

1 microsecond synchronized to GPS time
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Datum:

Reacquisition:
Hot Start:
Warm Start:

Cold Start:

Default:

Programmable:

Draw:

Internal Battery:

Altitude:
Velocity:

Acceleration:

Water Seal:

Operating Temperature:

Storage Temperature:

Humidity:

Marks:

Connector:

ORBITGPS USER GUIDE

WGS-84

100msec

<1 second

<38 seconds

<42 sec

NMEA-0183 (V2.20)- GGA(L), GSA(L), GSV(5), RMC(1)

Additional NMEA- VTG, GLL / SIRF Binary

80mA at 3.3V; DC power adaptor

3v (for GPS module only)

<18,000 meter

< 515 meter/second

<49

IPX7
-20C to +60T

-40Cto 70T

5% to 95%, non-condensing

FCC, CE, RoHS

LP11631 - DB9 with cigarette lighter power adaptor;

LP11632 -DB9 with power on Pin9.
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Depth:
Width:
Height:

Weight:

62.0mm
46.1mm
18.0mm

959

NOTE: This equipment has been tested and found to
comply with the limits for a Class B digital device pursuant
to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful
interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy

and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference
to radio or television reception, which can be determined by turning the equipment off and
on, the user is encourages to try to correct the interference by one or more of the following

measures:

* Reorient or relocate the receiving antenna

* Increase the separation between the equipment and receiver

» Connect the equipment into an outlet on a circuit different from that to which the receiver

is connected

* Consult the dealer or an experienced radio/TV technician for help

CAUTION: Changes or modifications to this equipment not expressly approved by the
party responsible for compliance could void the user’s authority to operate the equipment.

"2ty (M

OrbitGPS LLC hereby, declares that this device is in compliance with the essential
requirements and other relevant provisions of Directive 1999/5/EC. A
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(a) OrbitGPS'’s hardware Products are warranted against defects in workmanship and materials for a period of twelve (12) months
from the date of shipment by OrbitGPS'’s reseller to its customer, but in no event more than fifteen (15) months from shipment of the
Products by OrbitGPS, unless otherwise provided by OrbitGPS in writing, provided the Product remains unmodified and is operated
under normal and proper conditions. Warranty provisions and durations on software, integrated installed systems, Product modified
or designed to meet specific customer specifications (“Custom products”), remanufactured products, and reconditioned or upgraded
products, shall be as provided in the applicable Product specification in effect at the time of purchase or in the accompanying
software license; (b) Spare parts (i.e. Parts, components, or subassemblies sold by OrbitGPS for use in the service and
maintenance of Products) are warranted against defects in workmanship and materials for a period of thirty (30) days from the date
of shipment. Spare parts may be new or originate from returned units under the conditions set forth in subsection (d) below; (c) For
repairs on OrbitGPS-branded hardware Products under this Agreement, including repairs covered by warranty, the repair services
provided are warranted against defects in workmanship and materials on the repaired component of the Product for a period of thirty
(30) days from the shipment date of the repaired Product, or until the end of the original warranty period, whichever is longer; and (d)
Products may be serviced or manufactured with parts, components, or subassemblies that originate from returned products and that
have been tested as meeting applicable specifications for equivalent new material and Products. The sole obligation of OrbitGPS for
defective hardware Products is limited to repair or replacement (at OrbitGPS'’s option) on a “return to service depot” basis with prior
OrbitGPS authorization. Solution Provider is responsible for shipment to OrbitGPS and assumes all costs and risks associated with
this transportation; return shipment to the Solution Provider will be at OrbitGPS'’s expense. Solution Provider shall be responsible for
return shipment charges for product returned where OrbitGPS determines there is no defect (“No Defect Found”), or for Product
returned that OrbitGPS determines is not eligible for warranty repair. No charge will be made to Solution Provider for replacement
parts for warranty repairs. OrbitGPS is not responsible for any damage to or loss of any software programs, data or removable data
storage media, or the restoration or reinstallation of any software programs or data other than the software, if any, installed by
OrbitGPS during the manufacture of the Product; (e) Except for the warranty applying solely to the repaired component arising from
a repair service as provided in (c) above, the aforementioned provisions do not extend the original warranty period of any Product
that had either been repaired or replaced by OrbitGPS; (f) The above warranty shall not apply to any Product () which has been
repaired, tampered with, altered or modified, except by OrbitGPS'’s authorized service personnel; or (Il) in which the defects or
damage to the Product result from normal wear and tear, misuse, negligence, improper storage, water or other liquids, battery
leakage, use of parts or accessories not approved or supplied by OrbitGPS, or failure to perform operator handling and scheduled
maintenance instructions supplied by OrbitGPS; (lll) which has been subjected to unusual physical or electrical stress, abuse, or
accident, or forces or exposure beyond normal use within the specified operational and environmental parameters set forth in the
applicable Product specification; nor shall the above warranty provisions apply to any expendable or consumable items, such as
batteries, supplied with Product. EXCEPT FOR THE WARRANTY OF TITLE AND THE EXPRESS WARRANTIES STATED
ABOVE, ORBITGPS DISCLAIMS ALL WARRANTIES ON PRODUCTS FURNISHED HEREUNDER INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR USE. ANY IMPLIED WARRANTIES THAT MAY
BE IMPOSED BY LAW ARE LIMITED IN DURATION TO THE LIMITED WARRANTY PERIOD. SOME STATES OR
COUNTRIES DO NOT ALLOW A LIMITATION ON HOW LONG AN IMPLIED WARRANTY LASTS OR THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR CONSUMER PRODUCTS. IN SUCH STATES OR
COUNTRIES, FOR SUCH PRODUCTS, SOME EXCLUSIONS OR LIMITATIONS OF THIS LIMITED WARRANTY MAY NOT
APPLY. The stated express warranties are in lieu of all obligations or liabilities on the part of OrbitGPS for damages, including but
not limited to, special, indirect or consequential damages arising out of or in connection with the use or performance of the Product or
senvice. OrbitGPS's liability for damages to Solution Provider or others resulting from the use of any Product or service furnished
here under shall in no way exceed the purchase price of said Product or the fair market value of said service, except in instances of
injury to persons or property.

To the fullest extent allowed by law, the warranties and remedies set forth in this agreement are exclusive and in lieu of all other
warranties terms or conditions, express or implied, either in fact or by operation of law, statutory or otherwise, including without
limitation warranties terms or conditions of/as to satisfactory quality, merchantability, fitness for a particular purpose, conformance to
contract, correspondence with description and non-infringement, all of which are expressly excluded. OrbitGPS's warranties herein
are granted only to Distributor, and are not extended to any third parties that, for the avoidance of doubt, include any resellers,
agents or dealers of Distributor.

OrbitGPS neither assumes nor authorizes any other person to assume for it any other liability in connection with the sale, installation,
maintenance or use of its products, and OrbitGPS provides no warranty whatsoever for any non-standard Products supplied by it
hereunder.

ORBITGPS SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS TESTING AND EXAMINATION DISCLOSE THAT THE
ALLEGED DEFECT IN THE PRODUCT DOES NOT EXIST OR WAS CAUSED BY DISTRIBUTOR'S, OR DISTRIBUTOR'S
RESELLER, OR END USER’'S, OR ANY THIRD PERSON'S MISUSE, NEGLIGENCE, IMPROPER INSTALLATION OR
TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR, OR ANY OTHER CAUSE BEYOND THE INSTALLATION OR TESTING,
UNAUTHORIZED ATTEMPTS TO REPAIR, OR ANY OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR BY
ACCIDENT, FIRE, LIGHTNING OR OTHER HAZARD.
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Before you use the Serial GPS receiver, it must be configured to operate with our mobile
computer and applications.

If you have a problem using the Serial GPS receiver, contact your facility's Technical or
Systems Support. If there is a problem with the equipment, they will contact the OrbitGPS
Support Center:

Email: support@OrbitGPS.com

For the latest version of this guide go to http:/mww.OrbitGPS.com/support
OrbitGPS

25 Old King's Highway North Suite 13
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Darien, CT 06820

USA
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